
CONNECTIONS WEEKLY SYSTEM UPDATE 
    

  

Memo          
To: Implementation Coordinators 
From: CONNECTIONS Communications   
CC: LAN Administrators, Keyusers, OCFS -Directors of Services, 
           CONNECTIONS Project Team  
Date: October 10, 2002 
Re: Activities for the week of 10/11/02 – 10/18/02  
 
1. Upcoming Changes on CONNECTIONS Workstations 

A).  New screen resolution in Citrix – We are pleased to announce that 
in the next few weeks, the CONNECTIONS Project will be implementing a 
screen resolution change to 95% on workstations when users are in a 
Citrix Session.  A common complaint that has been heard by our 
CONNECTIONS Implementation Staff from districts/agencies over the last 
year is that once users were in a Citrix session, users were finding it 
difficult to access other desktop programs, i.e. Exchange/Outlook Email.  
This ease of use improvement will help users navigate between the Citrix 
session and other desktop functions.  For CONNECTIONS Windows 2000 
workstations, when users login to a CONNECTIONS Citrix session, they 
will see two START buttons; one will be the Citrix session and below that 
will be the user’s PC toolbar.  For CONNECTIONS NT 3.51 workstations, 
when users login to a CONNECTIONS Citrix session, they will be able to 
minimize or move the Citrix window to access other desktop programs.  
Additional materials regarding the resolution change will be provided in the 
next few weeks.    
 
B).  Upgrade to Citrix – Users can expect to see major improvements 
and enhancements to the Citrix ICA client in the very near future.  We are 
upgrading our current version of Citrix (Metaframe 1.8) to ICA Client 
version 6.30.1050.  The major benefit of this upgrade will be that the effect 
of “disconnects” or “outages” will be minimized.  With implementation of 
the new Citrix client, when a connection to a server is broken, users will 
have a new feature called “Auto Client Reconnect”.  “Auto Client 
Reconnect” means that when the Citrix client detects that its connection to 
a server is broken, it will begin a “re-connect” sequence.  The Citrix client 
will then attempt to re-connect three times and stop if re-connection fails. 
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C).  15 Minute Citrix Session Disconnected State  
As you know, with our current Citrix client, when a connection to a Citrix 
server is broken, users receive a message that informs them that a “Citrix 
server is unavailable” and requires the user to log-on to a new Citrix 
session.  When this happens, work in progress is temporarily lost and 
often requires a call to the Help Desk for retrieval.   
 
As a result of the upcoming Citrix upgrade, an additional enhancement, 
the “15 minute disconnect” interval, will be implemented in mid-November 
2002.  When the Citrix client detects that its connection to a server is 
broken, the Citrix session will shift into a “disconnected state”.  This 
means that when your Citrix session shifts into a “disconnected state”, 
your session will “stay alive” on the Citrix server for 15 minutes.  The 
benefit of being in a “disconnected” state, is that if you try to log back into 
Citrix and, the connection to the Citrix server is available within that 15 
minute interval, you will be reconnected to your session in the exact place 
you left off prior to the timeout or network interruption.  For example, if you 
were typing information into the Notes tab of the CPRS prior to the 
disconnect, after you log back into Citrix, you will return to the exact place 
you were entering information in the Notes tab prior to the disconnect.     
 
Additional information regarding the above referenced activities will be 
available to districts and agencies in the next few weeks.     

 
2. CONNECTIONS Patch, Build 15.1.01 

CONNECTIONS Patch, Build 15.1.01 has been scheduled for Friday 
evening, October 25th between the hours of 6pm and 11pm.  Build 
15.1.01 Release Notes and specifics regarding the schedule for 
CONNECTIONS Build 15.1.01 will be forthcoming late next week.   
 
Staff will not be able to access the CONNECTIONS Application during this 
time.  CONNECTIONS Downtime Procedures will be implemented for the 
transmission of CPS Reports between the SCR, Local Districts and ECS 
during this timeframe.  Network Exchange Email will be available during 
this time period.  

 
3. CONNECTIONS-IN-A-BOX (CIAB) Reconciliation Project  

***Reminder*** CIAB reconciliation spreadsheets are due by COB 
10/16/02.  Please send completed spreadsheets to Bill Bombardier at 
OCFS at the following address:  Bill.Bombardier@dfa.state.ny.us . In 
addition, if there are any discrepancies regarding CIAB information 
contained on the reconciliation spreadsheets, please notify Bill Bombardier 
(518) 473-5845. 
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As referenced in the Weekly Update last week, the communication 
materials regarding the return of CIAB devices that were initially 
distributed as part of the baseline allocation in 1996 were sent to targeted 
CONNECTIONS Local District and Voluntary Agency Implementation 
Coordinators on 10/02/02.  The communication materials referenced 
above included the following:   

� Letter from Zack Zambri, CONNECTIONS Project Director, dated 
10/02/02  

� CIAB reconciliation spreadsheet  
� Instructions for completing the spreadsheet 

 
Please Note:  We would like to clarify that the CIAB workstations that the 
CONNECTIONS Project is requesting be returned to OCFS, are any 
baseline CIABs that were allocated in 1996, however, were not returned 
when they were replaced with the Y2K compliant CIABs in December 
1999.      
 
For reference information, the CONNECTIONS CIAB Reconciliation 
materials are posted in Public Folders.   The path to these materials is as 
follows:  Statewide>CONNECTIONS>Alerts and Notices   

  
4. Powerdown at 111 8th Ave. NYC: 

There is a scheduled powerdown for 111 8th Ave. (New York City) on   
Sunday, 10/27/02, beginning at 5:00 am and concluding at 5:00 pm on 
Sunday, 10/27/02.  NYC network servers and e-mail will be down during 
this time.  CONNECTIONS will not be available to most sites whose 
network is supported through 111 8th Avenue.  The exception to this is 
ECS, where CONNECTIONS will be operational, however, email will not 
be available.  Any effected NYC area sites whose network is supported 
through 111 8th Avenue, should review current procedures for 
transmission of CPS reports with the State Central Register. 

 
5. Case Management Staffing and Equipment Survey Update 

***Reminder*** The submission date for the return of the surveys has 
been extended to the end of October.   
As highlighted over the last several weeks, the information we receive 
from case management staff and equipment surveys will be used to shape 
the Project’s over-all plans for the future.  Therefore, it remains important 
for districts and voluntary agencies to submit completed case 
management surveys as soon as possible.   
 
As previously mentioned, we have received completed case management 
surveys from almost all local districts.  Many voluntary agencies, however, 
have not yet responded to the survey.  We would like to thank those 
districts and agencies that submitted completed surveys.  For any districts 
and voluntary agencies that have not yet submitted completed surveys, 
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we again would encourage you to do so as soon as possible.  The link to the 
survey is as follows:   
http://172.28.22.37/onlinesurvey/survey.asp 
 
If you need assistance completing the survey please contact your Regional 
Office CONNECTIONS Implementation Staff member.  OCFS 
CONNECTIONS Regional Office Implementation staff are listed below.  
 
ARO – Joann Bisogno, 518-486-7216 
BRO - Mary Arnone, 716-847-3028  
NYCRO - Mike Prendergast, 212-383-1768, Earl Thomas, 212-383-1854, 
Sharone Jones, 212-383-1872 
RRO - Cynthia Brookins, 716-238-8562 
SRO - Cliff Pelton, 315-423-5596 
YRO - Andrea Straker 914-377-2081 
   
� In New York City ACS, Management Information Systems is coordinating 

the completion/submission of the survey. Any questions should be 
directed to Dan Sedlis or Henry Wells.    

 
� CIAB sites will need to dial in and launch the Internet Explorer (found in 

Program Manager) in order to access the survey.  After launching the 
Internet Explorer, the URL address can then be entered (or copied and 
pasted) in the URL address area on the Web browser.  

 
6. Desktop PC Replacement Project (the remaining 25%) 

***Reminder*** Region 2 (Rochester) - Reconciliation spreadsheet must 
be returned by October 17, 2002.    
Please note that the original dates for the rollout have shifted and rollout of 
the new personal computers is expected to begin in the Albany Region 
(Region 4) in November 2002.  At the present time, our primary focus for   
PC replacement will be on the Albany, Syracuse and Rochester Regions 
(Region 4, 3, and 2).  Please keep in mind that districts/agencies that are 
scheduled for December through January 2003 do not need to submit 
reconciliation spreadsheets at the present time.  For reconciliation 
spreadsheet due dates for the rest of the state please refer to the 
Implementation Schedule below.   
 
Implementation Plan  

 
� Region 4 (Albany) - Region 4 targeted to commence in November 

2002.  Reconciliation spreadsheet must have been returned by 
September 13, 2002.   

� Region 3 (Syracuse) - Region 3 targeted to commence November 
2002.  Reconciliation spreadsheet must have been returned by 
September 25, 2002.   
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� Region 2 (Rochester) - Region 2 targeted to commence November 
2002.  Reconciliation spreadsheet must be returned by October 17, 
2002.    

� Region 1 (Buffalo) – Region 1 targeted to commence December 
2002.  Reconciliation spreadsheet must be returned by November 
8, 2002.    

� Region 5 (Yonkers) – Region 5 targeted to commence December 
2002.  Reconciliation spreadsheet must be returned by December 
2, 2002.   

� Region 6 (NYC) – Region 6 targeted to commence January 2003.  
Reconciliation spreadsheet must be returned by December 23, 
2002.    

 
All completed reconciliation spreadsheets must be in Excel format.  When 
completing district/agency spreadsheets, please do not send the entire 
regional spreadsheet to Dave Kislowski.  Please copy and paste your 
district/agency information into a new Excel spreadsheet and then send 
that information to Dave Kislowski.  Reconciliation spreadsheets in any 
other format will not be accepted.    
 
Instructions for copying/pasting your district/agency information in a new 
Excel spreadsheet are as follows: 
 

o Highlight all sections that relate to your district/agency. 
o Select “Copy” from the Edit Menu Item. 
o Click the “Start” button and select “Programs” and then 

select Microsoft Excel. 
o After the new Excel spreadsheet opens, place your curser 

into the first open field on the spreadsheet. 
o Select “Paste” from the Edit Menu Item. 
o Complete a “File, Save As” to your local C Drive. 
o Save it to Data, Word.  
o Name the file and Save as Type “Microsoft Excel 

Workbook”. 
o Click the Save button. 
o Click the “File” menu item and select “Send To” Mail 

Recipient as Attachment. 
o Send to Dave Kislowski at the following address: 

 Mailto Dave.Kislowski@dfa.state.ny.us  
 
For reference information, the CONNECTIONS 25% Desktop PC 
Replacement communication materials that were sent on Thursday 
August 15th, 2002 are posted in Public Folders.   The path to these 
materials is as follows:   
Statewide>CONNECTIONS>Desktop PC Replacement>25% 
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Please keep in mind that the reconciliation spreadsheets are time 
sensitive and require targeted response dates.  In addition, please notify 
Dave Kislowski at OCFS about any discrepancies regarding PC 
information contained on the reconciliation spreadsheets.  His telephone 
number is 518-473-4770.     
 
Please Note:  The above referenced desktop pc replacement project 
does not include supplemental equipment, CIABs, laptops, printers 
or servers.   
    

7. CONNECTIONS System Down Time 
Due to regularly scheduled maintenance CONNECTIONS will be 
unavailable on: 
  
Friday, 10/11/2002 from 5:00 am - 7:00 am 
Friday, 10/18/2002 from 5:00 am - 7:00 am 

 
8. Microsoft Exchange Servers 

Due to regularly scheduled maintenance on MS Exchange E-mail 5.0 
servers, all Exchange E-mail 5.0 servers will be unavailable on:  
 
Sunday, 10/13/2002 from 1:00 am - 6:00 am 
Sunday, 10/20/2002 from 1:00 am - 6:00 am 
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